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Thank you for purchasing Print Artist Gold 4.0. We hope you enjoy it!

This document contains last-minute information and answers to frequently asked 
questions not found in the Help files or in the manual.  If, after reading this 
document, you need additional assistance, please refer to the "Contacting Sierra" 
section below and we'll be happy to assist you.
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1.  INSTALLING PRINT ARTIST 4.0 GOLD
Mininum Requirements:

Print Artist 4.02
Windows 95
Minimums: 486DX/33+, 8 MB RAM, 110 MB free HD space
Premium: Pentium+, 16 MB RAM, SVGA 800x600@16 Bit high color, 4X CD ROM
NOTE: 8 MB systems may experience long wait times loading and printing complex 
projects.

What's on the CDs?

CD 1: 
* Print Artist Installer (setup.exe)
* Print Artist 4.02

CD 2
* Print Artist Platinum Graphics Collection

Instructions:

Insert CD #1 into the drive.  After a few seconds, a screen with "Install" and 
"Cancel" buttons will appear.  Click the "Install" button and follow the on-screen 
prompts.

If the Print Artist installer dialog does not appear upon inserting CD #1 into the 
drive, Click on Start, then Run. In the Command Line field, type the letter of the 
drive followed by :\SETUP.EXE, for example: D:\SETUP.EXE. Follow the on-screen 
prompts to complete the installation.

2.  PLATINUM COLLECTION BONUS CLIP ART AND PHOTOGRAPHS



Print Artist Gold includes a Bonus CD with over 15,000 clip art images (GFX files) 
and 5,000 photos (JPG files)!

Installing Clip Art (GFX)Graphics
1. Insert CD 2 into the CD ROM drive
2. Double Click "Setup.exe" in the root of the CD
3. Follow the on screen prompts to complete the installation.
4. Refer to the Graphics Catalog for thumbnails of the graphics to be installed.

Setting Up Print Artist to Use the Bonus Clip Art (GFX) Graphics on CD 2 WITHOUT 
Installing.
This option is recommended for ADVANCED USERS ONLY.  The advantage of this option 
is that the graphics will remain on the CD, saving hard drive space.  The 
disadvantage of this option is that the CD must be in the CD drive BEFORE starting 
Print Artist in order to use the graphics every time you run Print Artist.

1. Start Print Artist
2. Insert CD #2 into the CD ROM drive
3. Bring up a layout on the workspace
4. Under the File Menu, choose the Directory Setup command. This dialog tells Print
Artist where to search for the program's graphics, layouts, and fonts.
5. Delete all of the text in the "More Print Artist (*.gfx):" graphic directory 
line and click on the BROWSE button
6. Change the "Drive" line to your CD ROM drive and click OK
7. Print Artist will search the CD for the bonus graphics.  This may take a few 
minutes.
8. Once Print Artist has finished finding the graphics, click OK again
9. The Graphics Grabber will now update to include the 15,000 new GFX graphics.  
This will take a few minutes.
10. Once the Graphics Grabber has finished updating, the new graphic categories 
will appear in the Graphics Grabber with "(Print Artist Platinum)" in the category 
name.

Please Note:  The next time you run Print Artist, you will need to have CD 2 in the
CD drive. If you try to run Print Artist without CD 2 you will be asked to insert 
the CD or to change the Directory Setup to a different drive (e.g. your hard 
drive).

Options for Using the Bonus Photos (JPGs) on CD 2 in Print Artist

1. Moving Photos (JPGs) into the Default JPEG Directory:
* Find the *.jpg file you would like to use by looking through the PA Platinum 
Graphics Catalog.  The caption under the picture is the file name.  
* Copy the file from CD 2 into the default JPEG directory: C:\SIERRA\PA4GOLD (note:
if you changed the installation directory to something other than "SIERRA" then 
copy the .jpgs into the PA4GOLD directory wherever you installed it).
* The next time you run Print Artist the Graphics Grabber will update to include 
the images you've copied. You'll find the images under the category "JPEG Bitmap 
Files."

2. Import individual Photo (JPG) files:
* Find the *.jpg file you'd like by looking through the PA Platinum Graphics 
Catalog. The caption under the picture is the file name.
* Start Print Artist
* Bring up a layout on the workspace
* Insert CD 2
* Under the File Menu, Choose the Import command. 
* Select your CD drive in the "DRIVES" window
* Change the "LIST FILES OF TYPE" to JPEG (*.jpg)



* Select the directory in the DIRECTORIES box (the directory is indicated in the 
heading of the PA Platinum Graphics Catalog.)
* Select the file in the DOCUMENT NAME box
* Click the "OK" button
* The file will be copied into your default JPEG directory and appear in the 
Graphics Grabber under the Category "JPEG Bitmap Files"

3.  LATE BREAKING INFORMATION ABOUT PRINT ARTIST 4.0
SETUP

Removing CD during Installation
Removing Print Artist 4.0 CD during the installation may cause the setup program to
crash.

Anti-Virus Software
If you have any anti-virus software running on your system, you should disable it 
before installing Print Artist.

Other Software Programs
We recommend you exit out of any other software programs before installing and 
running Print Artist 4.0 due to memory constraints.  If you are experiencing 
lockups, general protection faults or other errors, exit out of any other software 
programs, reboot Windows, and then restart Print Artist.

Windows Debug Software
Be sure to disable Windows debug software before you try to install Print Artist.  
The debug kernel will conflict with the Print Artist installation.

Installing onto a Compressed Hard Drive
If you are using Stacker, DoubleSpace or similar drive compression technology 
software, be aware that Print Artist is already very compressed.  This means that 
you may have to free up more hard disk space than the minimum requirements for 
Print Artist before it will install correctly.  For example, installing the Typical
version of Print Artist may require up to 220  megabytes of free space on a 
compressed drive instead of the 110 megabytes needed on a normal uncompressed 
drive.

Font Installation
The Custom install gives you the option of installing 300 TrueType fonts. Windows 
95 supports approximately 1000 fonts.  Due to this limitation, Print Artist 
recommends that you check the number of fonts on your system before installing all 
of Print Artist's 300 TrueType fonts. Fonts will be installed into your Windows 
system directory. After installation they will be accessible from any of your 
Windows applications. You can install any extra fonts from the Print Artist CD at 
anytime by using the font installer in your Windows settings dialogue.  If you add 
more fonts after the initial install, be sure to reboot your computer before 
starting Print Artist.

4.  UPGRADING PRINT ARTIST 3.0 TO PRINT ARTIST GOLD 4.0
Print Artist 4.0 comes with all new layouts and thousands of new graphics utilizing
an improved color palette. Print Artist 3.0 graphics, layouts and documents can be 
converted for use in Print Artist 4.0 with a conversion utility called "Convert 3.0
Layout to 4.0".  The icon to run this utility can be found in your Sierra program 



group. The Convert 3.0 Layout to 4.0 utility also converts graphics, documents and 
layouts supplied by the Print Artist Users Club.

Please run the  "Convert 3.0 Layout to 4.0 Help" from your Sierra Group for 
instructions on converting your files.

5.  USING PRINT ARTIST 
Windows Display Settings
For optimal performance of Print Artist set your Windows display settings to 
800x600 resolution with 16 bit High Color. These options can be found in the 
Display dialog under your Windows Settings. 

If you are using Win 95 and prefer a 640x480 resolution you should make sure your 
task bar is set to Autohide. If not you will find some parts of Print Artist cut 
off. 

If you choose to use only 256 colors you may find that your specific video card may
slow down the performance of Print Artist. 
     
Import Limitations
When importing EPS, TIF, and WMF images (or pasting from the clipboard), Print 
Artist will sometimes say that the image is too complex to bring in.  Try reducing 
the complexity of the image by using a 3rd. party drawing program to remove 
unnecessary curves and lines.  Also, make the image smaller on your drawing program
page before you make the EPS, TIF, or WMF file.

Avery Business Cards
In addition to the business card layouts located in the stationery document type, 
you can find layouts for Precut Avery Business Card stock in the Labels Document 
type. 

Customizing Yearly Calendars
Calendars can be easily created by customizing existing text, dates, or graphics 
from the pre-designed layouts. To personalize your calendar, simply double click a 
section of text or graphic and replace it with your own choice. Due to memory 
restraints you will not be able to enter new text or graphics. 

Mouse Problems
Some users may experience problems when using Print Artist for Windows with 
Microsoft Mouse driver version 9.00.  These problems entail the mouse cursor 
jumping from one location to another when opening or using the palettes.  Sometimes
users may find that going to the Mouse Control Panel and turning off the "Locate" 
command will fix this situation; otherwise, upgrading to version 9.01 of the driver
should fix it.

Also, a program called "Animouse" that tries to take control of the mouse cursor is
incompatible with Print Artist, and should not be run in conjunction with it.

FONTS

Font Limitations
The Print Artist program has a limit of 1200 vertices per polygon.  TrueType or 
PostScript Type 1 font characters are allowed only one polygon, so the entire 
character must have no more than 1200 points.  Furthermore, curve splines in the 
font data are broken up into separate points along the curve.  There are very few 
fonts that can't work with PA (for example, a complicated font with a wood-cut 



effect, or one with frilly vines creeping in and out of the letters may be a bit 
too complex.)

Adding and deleting Fonts
After initial installation you can add fonts to your system by copying them from 
the Print Artist 4.0 CD directly into your system. For a list of the fonts supplied
with Print Artist, please refer to font catalog in the User Manual.  You can also 
delete unwanted fonts directly by finding them in the Windows system directory and 
deleting.   Open the Windows 95 Control Panel.  To do this, single left click on 
start, settings, then double left click control panel.  Go into the fonts section, 
select "File" then Install New Font. Select your CD-ROM drive from the drives 
pulldown menu.  Under Directories, select the Fonts directory.  Windows will 
"retrieve" the fonts available and you have the option to individually select the 
fonts you want to install or "select all" the fonts.  Once your selections are 
final, click on OK to install the fonts.

Classic Print Artist Fonts
The number of fonts you are shown when you use the Count button in the Print Artist
Directory Setup is the number of Classic Print Artist fonts you have. Not shown in 
this count are over 300 new TrueType fonts included with Print Artist 4.0, or any 
other that you currently have installed on your system. These fonts will be 
available to you in Print Artist and can be accessed from the font palette. All 
effects are possible on them.

PRINTING

Windows 95 and Print Area on some Laser Printers
When your documents are not printing centered on the page, you can use Print Artist
to correct this problem for all your Windows programs.  Run Print Artist, select 
any ready-made sign, then choose Print from the File menu.  Click on the Print Area
button, then click on the Printable Area Test button.  Windows will print a test 
page that you can measure for proper alignment.  Make sure that the Use Printable 
Area Values check box is unchecked, then Cancel from the Setup Printable Area 
dialog and the Print Control Panel / Preview dialog.  Quit Print Artist, then click
on the Start button, and choose Settings, Printers.  Select the default printer 
with your mouse, then choose Properties from the File menu.  Click on the Paper 
tab, then click on the Unprintable Area button.  The Printable Area Test page from 
your printer should be measured for unprintable area, according to the instructions
on the page.  Enter these measurements in the Unprintable Area dialog box and click
on OK.  Click on the OK button in the printer Properties dialog to permanently save
your settings.  The settings you just set will help all your Windows programs, 
including Print Artist, to print accurately on the paper.

Printer Notes
If you have a problem with perforation skipping when using the Epson 2550 driver 
under Windows 3.1, check its version number and make sure you have the latest one. 
The latest Epson 2550 driver from Microsoft (which is Universal Printer Driver 
V3.1.4, Epson LW 2550, v2.11) doesn't have this problem, and it also supports 360 x
360 printing.

If you are using a Citizen GSX 140 printer, you should use the latest Epson 2550 
driver instead of the usual Citizen driver.

Print Artist does not automatically support nonstandard (not 8.5 x 11) tractor feed
paper sources (for example, continuous business card or phone index card stock).  
If you are able to fit more than one business card on a standard size document, you
might have luck manually aligning them to fit the cardstock you are using.  Often, 
special stock length is evenly divisible by 11 inches, so you could fool the 
program into thinking it is dealing with regular tractor-feed paper and get the job



done.  In the Windows Printer Driver Setup in the Control Panel, choose "Cut Sheet 
on Tractor" under paper size.

Banner Printing
When you print a banner, check your Print Options to make sure that Margins are set
to minimal and Rotate is set to Automatic.  Also, make sure that the Use Printable 
Area Values in the Setup Printable Area dialog box is not set. 

General Document Printing
The message "Click and drag to position document" on the Hot Preview status line 
means that you have additional control over where your document print area will 
actually be printed to a sheet of paper. You can print your document in the Center 
of a sheet, against the upper left margin, against the upper center margin, or 
against the upper right margin, depending on the value chosen for Percent Size. 
Larger sizes mean fewer options.

Windows Print Manager and other Print Managers
You may experience longer printing times with some printers.  We recommend that you
disable any 3rd party print managers before attempting to print from Print Artist 
4.0.  For deskjet, inkjet, and bubblejet systems, setup the printer options to 
Econofast, or, Fast, or Best printing mode.    For Laser printers, be sure you are 
using Raster graphics instead of vector graphics.  

Cutting and Pasting
When you Cut or Copy any part of a Print Artist document, you put your work into a 
buffer which can then be pasted into any Windows application document which has a 
Paste menu item in the Edit menu. Such applications include (but are not limited 
to) word processors, spread sheets, and paint programs. However, colors of what you
cut and paste will most likely be different than what they were in Print Artist, 
because each application has it's own particular color palette. 

See Import Limitations above for more information.
If the pasted graphic is too complex the image either may fail to paste or an error
message may occur when the document is saved.  If this happens remove the pasted 
graphic, make the original simpler or smaller in the source program, and add the 
graphic again through copy and paste.

FULL DRAG

To avoid drawing problems in Print Artist, users running Windows 95 with full 
window dragging enabled should disable full window dragging while running Print 
Artist.  If you prefer running full window dragging, Print Artist has shipped with 
a file called "FULLDRAG.EXE" which will disable full window dragging while running 
Print Artist and enable full window dragging when exiting Print Artist.  
FULLDRAG.EXE can be found on the source CD in the "system" directory.  To install, 
drag FULLDRAG.EXE into the Sierra\PA4GOLD directory.

6.  CONTACTING SIERRA

A) Customer Service, Support, and Sales
B) Technical Support
C) Legal Information

A) Customer Service, Support, and Sales
----------------------------------
United States



U.S.A. Sales Phone: (800) 757-7707
International Sales:  (425) 746-5771 
Hours: Monday-Saturday 7AM to 11 PM CST,
Sundays 8 AM to 9PM CST 
FAX: (402) 393-3224

Sierra Direct
7100 W. Center Rd
STE 301
Omaha, NE  68106

United Kingdom

Cendant Software International Limited
Main: (0118) 920-9111
Monday-Friday, 9:00 a.m. - 5:00 p.m.
Fax:   (0118) 987-5603
Disk/CD replacements in the U.K. are £6.00,
or £7.00 outside the UK. Add "ATTN.: Returns."

2 Beacontree Plaza,
Gillette Way,
Reading, Berkshire
RG2 0BS United Kingdom

France

Cendant Software International Limited
Phone: (01) 46-01-46-50
Lundi au Vendredi de 9h à 19h 
Fax: (01) 46-30-00-65

Parc Tertiaire de Meudon
Immeuble "Le Newton"
25 rue Jeanne Braconnier 
92366 Meudon La Forêt Cedex
France

Germany

Cendant Software International Limited 
Tel: (0) 6103-99-40-40
Montag bis Freitag von 9h - 19Uhr
Fax: (0) 6103-99-40-35

Robert-Bosh-Str. 32
D-63303 Dreieich
Germany

On-Line Sales
CompuServe United Kingdom:GO UKSIERRA
CompuServe France:  GO FRSIERRA
CompuServe Germany:  GO DESIERRA
Internet USA:  http://www.sierra.com
Internet United Kingdom:  http://www.sierra-online.co.uk



Internet France:  http://www.sierra.fr
Internet Germany:  http://www.sierra.de

THE SIERRA NO-RISK GUARANTEE
The Promise: We want you to be happy with every Sierra product you purchase from 
us. Period. If for any reason you're unhappy with the product, return it within 30 
days for an exchange or a full refund...EVEN IF YOU BOUGHT IT RETAIL. (Hardware 
ordered direct must be returned within ten days.)  Please send back your product, 
signature required if mailing via US Postal Service.

The Only Catch: You've got to tell us why you don't like the game. Otherwise, we'll
never get any better. Send it back to us and we promise we will make things right. 
(If you bought it at a retail outlet, please send your original sales receipt.)

* Returns valid in North America only.

Disk and or Manual Replacement:

Product Returns:
Sierra On-Line Returns
4100 West 190th Street
Torrance, CA  90504

Sierra On-Line Fulfillment
4100 West 190th Street
Torrance, CA  90504

NOTE: To replace your disk(s) please send only Disk #1 (or the CD) and copy of your
dated Receipt, if less then 90 days.  After 90 days please include a $10 handling 
fee along with Disk / CD #1.  For Documentation, please include a $ 5.00 handling 
fee and a photocopy ONLY of disk #1.  Payment should be made at the time of your 
request.  Sorry, no credit cards.

* Returns to this address valid in North America only.

B) TECHNICAL SUPPORT
-------------------------
North America

Sierra On-Line offers a 24-hour automated technical support line with recorded 
answers to the most frequently asked technical questions. To access this service, 
call (425) 644-4343, and follow the recorded instructions to find your specific 
topic and resolve the issue. If this fails to solve your problem, you may still 
write, or fax us with your questions, or contact us via our Web site.

Sierra On-Line
Technical Support
P.O. Box 85006
Bellevue, WA 98015-8506

Main: (425) 644-4343
Monday-Friday, 10:00 a.m.- 6:45 p.m.  PST 
Fax:   (425) 644-7697

http://www.sierra.com
home@sierra.com 



United Kingdom

Cendant Software International Limited offers a 24-hour Automated Technical Support
line with recorded answers to the most frequently asked technical questions. To 
access this service, call (0118) 920-9111, and follow the recorded instructions to 
find your specific topic and resolve the issue. If this fails to solve your 
problem, you may still write, or fax us with your questions, or contact us via our 
Internet or CompuServe sites.

Cendant Software International Limited
2 Beacontree Plaza,
Gillette Way,
Reading, Berkshire
RG2 0BS United Kingdom

Main: (0118) 920-9111
Monday-Friday, 9:00 a.m. - 5:00 p.m.
Fax:   (0118) 987-5603

http://www.sierra-online.co.uk

France

Cendant Software International Limited
Parc Tertiaire de Meudon
Immeuble "Le Newton"  
25 rue Jeanne Braconnier
92366 Meudon La Forêt Cedex
France

Téléphone: 01-46-01-46-50
Lundi au Vendredi de 9h à 19h
Fax: 01-46-30-00-65

http://www.sierra.fr

Germany

Cendant Software International Limited
Robert-Bosh-Str. 32
D-63303 Dreieich
Deutschland

Tel: (0) 6103-99-40-40
Montag bis Freitag von 9 - 19Uhr
Fax: (0) 6103-99-40-35
Mailbox: (0) 6103-99-40-35

http://www.sierra.de

Spain

Cendant Software International Limited
Avenida de Burgos 9
1º-OF2



28036 Madrid
Spain

Teléfono: (01) 383-2623
Lunes a Viernes de 9h30 a 14h y de 15h a 18h30
Fax: (01) 381-2437

Italy

Contattare il vostro distribotore.

C) Sierra Warranty & Legal Information
-----------------------------------
You are entitled to use this product for your own use, but may not copy, reproduce,
translate, publicly perform, display, or reduce to any electronic medium or 
machine- readable form, reproductions of the software or manual to other parties in
any way, nor sell, rent or lease the product to others without prior written 
permission of Sierra.  You may use one copy of the product on a single computer.  
YOU MAY NOT NETWORK THE PRODUCT OR OTHERWISE INSTALL IT OR USE IT ON MORE THAN ONE 
COMPUTER AT THE SAME TIME.

UNAUTHORIZED REPRESENTATIONS: SIERRA WARRANTS ONLY THAT THE PROGRAM WILL PERFORM AS
DESCRIBED IN THE USER DOCUMENTATION. NO OTHER ADVERTISING, DESCRIPTION, OR 
REPRESENTATION, WHETHER MADE BY A SIERRA DEALER, DISTRIBUTOR, AGENT, OR EMPLOYEE, 
SHALL BE BINDING UPON SIERRA OR SHALL CHANGE THE TERMS OF THIS WARRANTY.

IMPLIED WARRANTIES LIMITED: EXCEPT AS STATED ABOVE, SIERRA MAKES NO WARRANTY, 
EXPRESS OR IMPLIED, REGARDING THIS PRODUCT. SIERRA DISCLAIMS ANY WARRANTY THAT THE 
SOFTWARE IS FIT FOR A PARTICULAR PURPOSE, AND ANY IMPLIED WARRANTY OF 
MERCHANTABILITY SHALL BE LIMITED TO THE NINETY (90) DAY DURATION OF THIS LIMITED 
EXPRESS WARRANTY AND IS OTHERWISE EXPRESSLY AND SPECIFICALLY DISCLAIMED. SOME 
STATES DO NOT ALLOW LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY LASTS, SO THE ABOVE
LIMITATION MAY NOT APPLY TO YOU.

NO CONSEQUENTIAL DAMAGES: SIERRA SHALL NOT BE LIABLE FOR SPECIAL, INCIDENTAL, 
CONSEQUENTIAL OR OTHER DAMAGES, EVEN IF SIERRA IS ADVISED OF OR AWARE OF THE 
POSSIBILITY OF SUCH DAMAGES. THIS MEANS THAT SIERRA SHALL NOT BE RESPONSIBLE OR 
LIABLE FOR LOST PROFITS OR REVENUES, OR FOR DAMAGES OR COSTS INCURRED AS A RESULT 
OF LOSS OF TIME, DATA OR USE OF THE SOFTWARE, OR FROM ANY OTHER CAUSE EXCEPT THE 
ACTUAL COST OF THE PRODUCT. IN NO EVENT SHALL SIERRA'S LIABILITY EXCEED THE 
PURCHASE PRICE OF THIS PRODUCT. SOME STATES DO NOT ALLOW THE EXCLUSION OR 
LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION OR 
EXCLUSION MAY NOT APPLY TO YOU.

Copyright (1998 Sierra On-Line, Inc.) 


